


Help on Help

The MailPlus online help system is designed to work for you.    For a suggested learning sequence, see Where to begin...? 
below. Whatever your background, you'll find it easy to navigate through online help:

n To begin learning about MailPlus tools and menus, just move the mouse pointer around the screen. Watch the HintLine at the
lower left for capsule descriptions of each feature.

n Click the Contents button above to display an outline of help topics. 
n Click Index to pop up the alphabetical list of help topics. 
n Click Help Menu to return to the starting help screen, which provides links to:

n The Screen Reference, a visual guide to MailPlus menus and buttons.
n The MailPlus QuickTour, an animated overview of how MailPlus works for you.
n The MailPlus Walkthrough, a self-paced, guided tour that helps you compose and send your first graphic E-mail message.

Where to begin...?
1 If you haven’t already viewed the MailPlus QuickTour, take a few moments to do so.
2 Try the MailPlus Walkthrough, for a hands-on introduction to graphic E-mail. 
3 Peruse the half-dozen introductory help topics in the Basics of Graphic E-mail section, starting with Composing Graphics. 

Click the Next and Previous (right and left arrow) buttons to step through topic sequences.

MailPlus is remarkably easy to use, and rewards a playful, experimental approach. However, it does offer a couple of unique 
concepts (such as Intelligent Formatting) — so covering those introductory help topics may spare you some confusion. 
Once you’re off and running, the Contents outline and Index provide speedy access to all the additional help you’ll need, no 
matter what you want to accomplish. Enjoy! 

For more information...
Layout packs are available that let you extend MailPlus’ capabilities in new directions. For more information, visit the MailPlus 
Add-on Pack page on the World Wide Web, or contact your SPC dealer.
For late-breaking tips on using MailPlus, consult the MailPlus Frequently Asked Questions page on the World Wide Web.
For direct contact information, see Contact Information and Technical Support.
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Screen Reference Click a category:

Menus Gallery Tabs Main Buttons Edit Buttons 

Gallery Tabs 
Layouts
Shows the different ways MailPlus can present your information. Layouts 
are graphic compositions that deliver a message. There are two basic 
kinds of MailPlus layouts: picture layouts (such as Greeting Cards) for 
illustrated notices and correspondence, and structure layouts (such as 
Calendars) for presenting organized information. See Exploring the 
Layouts.

Designs
Shows the different ways MailPlus can present your information. Designs
offer a range of backgrounds you can apply to structure layouts. Greyed 
out if not available. See Choosing a Design.

Color Schemes
Shows alternative color combinations for elements in a MailPlus graphic. 
The color scheme determines the color of each element; the colors are 
coordinated to work together. Greyed out if not available. See Choosing a 
Color Scheme.

Stamps
Shows a collection of foreground visual elements (often combined with 
text) used to send a particular message. For example, add a light bulb to 
identify a new idea. Most stamps go on the Foreground layer of the 
MailPlus graphic. See Adding Stamps and Floating Text.

Textures
Shows a collection of effects you can add to the background of a MailPlus
graphic or to certain elements within it. For example, show boxed text on 
a background of pebbles or satin. Greyed out if not available. See Adding 
Texture.

Menus 

File menu 
New Displays the original sample graphic in the Edit Window 

so you can begin composing a new graphic. 
Open... Displays a standard Windows dialog that lets you open 

an existing MailPlus graphic (*.MPC) file.
Save Saves the active graphic under its current name. If it’s 

still unsaved (“Untitled”), the Save As... dialog 
automatically appears.

Save As... Displays a dialog prompting you to enter a directory and
file name for the active graphic, then saves it under 
that name.

Save As GIF... Saves the active graphic as a GIF file that can be 
attached to any E-mail message or used for other 
purposes (such as in a Web page). See Sending 
Graphics.

Package GIF Turns the active graphic into a GIF object that can be 
dragged and dropped into a suitable E-mail program. 
See Sending Graphics.

Print... Prints the active graphic.
Send Turns the active graphic into a message in the 

designated, compatible E-mail program. See Sending 
Graphics.

Send Setup... Displays a dialog that lets you designate which 
compatible E-mail program to use with the Send 
command.

Exit Closes MailPlus. You’ll be prompted to save changes 
made since the last save.



Edit menu 
Undo Undoes the most recent change to the active graphic. 

Dimmed when not available.
Cut Deletes the selected element from the Edit Window 

AND places a copy on the Windows Clipboard. TIp: 
You can also right-click a stamp or point.

Copy Copies the selected element to the Windows Clipboard. 
Tip: You can also right-click a stamp or point, or a 
picture on the Foreground or Background layer.

Paste Inserts the contents of the Windows Clipboard at the 
selection point. Tip: You can also right-click a stamp or
point, or a picture on the Foreground or Background 
layer.

Paste Special... Displays a dialog box that lets you choose one of 
several formats to be used when pasting. Then inserts 
the contents of the Windows Clipboard at the insertion 
point, using the selected format.

Clear Deletes the selected element. You can use Undo to 
reverse the deletion. Same as pressing the Delete key.

Turn Off/On Sample 
Text

Switches sample text on and off. Available only after 
you have changed some text. See Replacing Sample 
Text.

Spelling... Performs a spelling check and (if possible errors are 
found) displays a dialog that lets you specify 
replacement text. Tip: You can also right-click on the 
active graphic.

Font... Displays a dialog that lets you select a font for all text 
used in the graphic.

Links... Opens linked documents or changes links.
Object Allows editing of an OLE object. This is the standard 

OLE Object menu command; it changes according to 
the type of object selected. See Adding an OLE 
Object.

Insert menu 
Text Displays a submenu with a choice of text elements you 

can to insert on the graphic’s Intelligent layer. Choices 
are greyed out if unavailable. See Adding a Title, 
Subtitle, Top/Bottom Text, or Sign-off.

Picture... Displays a dialog that lets you choose a picture file (for 
example, .BMP or .GIF) to insert on the graphic’s 
Intelligent layer. See Adding a Picture or Background.

Object... Displays a dialog that lets you choose an object to 
insert on the graphic’s Intelligent layer. See Adding an 
OLE Object.

Help menu 
 Help Displays the main menu screen of MailPlus’ online help.
QuickTour... Plays the MailPlus QuickTour, a brief overview of the 

product.
About... Displays version and copyright information for MailPlus.

Main Buttons 
Send
Click to turn the active graphic into a message in the 
designated, compatible E-mail program. Same as menu 
command File/Send.

Package GIF 
Click to turn the active graphic into a GIF object that can be 
dragged and dropped into a suitable E-mail program. Same as 
menu command File/Package GIF.



Save As GIF 
Click to save the active graphic as a GIF file that can be 
attached to any E-mail message or used for other purposes 
(such as in a Web page). Same as menu command File/Save 
as GIF.

Print 
Click to print the active graphic. Same as menu command 
File/Print.

New 
Click to begin composing a new graphic. The original sample 
graphic will be displayed in the Edit Window. Same as menu 
command File/New.

Principal Edit Buttons 
Use these buttons at the bottom of the Gallery to change the appearance of the current MailPlus graphic. The first row contains 
general purpose buttons.

Note
These and other Edit buttons vary, depending on the current layout and selection. To learn more about them, see the help for the
current type of layout.

Insert
Click to see invitations for adding text elements. See Inserting New 
Elements.

Bigger
Click to make the selected element and other elements like it bigger.

Smaller
Click to make the selected element and other elements like it smaller.

Reset
Click to restore the selected element (or the whole layout) to its default 
size and style.

Glyph Style
Click to cycle through a set of glyph styles.

Border Style
Click to cycle through a set of border styles.

Bar Style
Click to cycle through a set of bar styles.



Composing Graphics

When you first open MailPlus, here’s what you’ll see:

To learn about a specific feature of the MailPlus interface, consult the Screen Reference.

Creating your own graphic
To create a new graphic, you modify the sample graphic in the Edit Window – simply by typing your own text and clicking to 
make selections from the tabs on the MailPlus Gallery: 

Here’s a quick summary of the key steps to create your own graphic:
Basic steps: For details, see: 
n Use the Layouts tab to load a new MailPlus 

layout—a basic graphic message.
Next topic

n Read and replace the layout’s sample text 
text with your own added text.

Replacing Sample Text 

Optional steps: For details, see: 
n Customize the layout elements to suit your 

message.
Inserting New Elements 

n Add your own picture or background. Adding a Picture or 
Background 

n Use the Stamps tab to attach a colorful 
callout or cartoon element (starburst, thought 
bubble, and so on).

Adding Stamps and Floating 
Text

n To customize your graphic, use the 
Designs, Color Schemes, or Textures tab 
and apply any of the available effects.

Choosing a Design 
Choosing a Color Scheme 
Adding Texture 

 
Where to go from here:
n To continue the sequence of help topics covering basic information, click the Next Topic (right arrow) button above.
n For a self-paced, guided tour that helps you compose and send your first graphic E-mail message, take the MailPlus 

Walkthrough.
n For greater depth and details, consult the help topics in the section, Modifying Graphics.



About Intelligent Formatting

MailPlus’ Intelligent Formatting handles design details for you! 
n It arranges elements according to the layout and design you choose. 
n It manages color coordination, overall size, and proportions. 
n It selects a font size for text based on the number and size of elements in the MailPlus graphic. 
n It adjusts the size of elements when you make changes, so everything always fits and looks balanced.

Regions and Layers
To maintain an attractive appearance when you make changes, MailPlus uses regions on the Intelligent layer to position 
elements. Intelligent Formatting controls the placement of text and picture elements inside regions, but you can move these 
elements from one region to another.

If you want precise control of the placement of pictures, move them from the Intelligent layer to the Background layer or 
Foreground layer. Elements on the Intelligent layer appear on top of pictures on the Background layer and beneath pictures on 
the Foreground layer.

Note
n To see the regions, select an element on the Intelligent layer and start to move it. If you select a text element, MailPlus 

displays drop targets for text. If you select a picture, you see drop targets for pictures.



Exploring the Layouts

Layouts in MailPlus are graphic compositions that deliver a message. There are two basic kinds of MailPlus layouts: picture 
layouts (such as Greeting Cards) for illustrated notices and correspondence, and structure layouts (such as Calendars) for 
presenting organized information. Structure layouts are based on familiar idioms like relationships, scheduling diagrams, charts, 
and tables. For details, see the help topics in the section, Working with Structure Layouts.

MailPlus’ Intelligent Formatting (see the previous topic) fosters “visual brainstorming” — just explore the various layouts, 
applying them to your graphic as you go, until you find the effect you like best.

To explore the layouts:

1 Click the  Layouts tab if it’s not already on top. 
On the Layouts tab, the layouts are grouped into categories for quick access. Layouts shown with a small down arrow 

 provide additional alternatives as variations.
2 Click to display the layouts you’re interested in.

n To expand or collapse the list, click any category heading.

n To display a layout’s variations, click the down arrow  to its right. To close the variations, click the layout heading or one 
of the small circles to the right of the list. Alternatively, click another layout name to display the variations of another layout.

3 Click a layout’s name to apply it to the graphic in the Edit Window. Intelligent Formatting retains any text you’ve added while 
supplying appropriate sample text.

Tip: You can also press the Up Arrow or Down Arrow key repeatedly to step through the displayed layouts.

As you preview each layout, read its sample text to understand its elements and choose the most appropriate way of 
communicating your message. When you find the most suitable layout, you’re ready to replace the sample text and customize 
the graphic (see the following topics).
 
Note
n If you choose a variation and then close the variations for the layout, MailPlus substitutes your chosen variation for the layout. 

For example, display the variations for the Pie layout, click 3-D, and then close the Pie variations. The picture of the 3-D pie 
replaces the picture of the basic pie; when you choose the Pie layout, MailPlus uses the 3-D variation instead of the basic pie.

Aquiring additonal layouts
Layout packs are available that let you extend MailPlus’ capabilities in new directions. For more information, visit the MailPlus 
Add-on Pack page on the World Wide Web, or contact your SPC dealer.

See Also
Adding a Picture or Background 
Topics in the section Modifying Graphics 



Replacing Sample Text

Sample text is built-in sample text supplied by MailPlus. You replace it with the actual text you want to appear in the graphic.

To replace sample text:
1 Click the first sample text element to select it.
2 Type your text and press Tab to select the next sample text element.
3 Continue typing text and pressing Tab until you type all your information.
4 Click the background of the MailPlus graphic when you finish typing.

Notes
n To delete unneeded sample text, click it and press Delete.
n To delete all sample text after you have added your own text, choose Turn Off Sample Text from the Edit menu. Choose Turn

On Sample Text to restore sample text.
n For the Day, Week, and Month layouts, you can use Turn Off Sample Text to remove all sample text before adding your own. 

Turn Off Sample Text is not available for Chart layouts.

See Also
Inserting New Elements
Topics in the section, Working with Text.



Sending Graphics

MailPlus can send graphic E-mail in three ways. The one you choose depends on which E-mail program you’re using:
n If you’re using a compatible E-mail program, MailPlus can launch it automatically and pass the graphic on as a message.
n You can “package” the graphic as a GIF object that can be dragged and dropped into many E-mail programs.
n A third option (that works with any E-mail program) is to save the graphic as a separate GIF file and then use the E-mail 

program’s Attach command to insert the graphic into a message.

Here’s a quick summary of these methods, in order of preference:
If you  ’  re using:  Click: To:
America Online 3.0
Eudora Pro 3.0
Microsoft Exchange
Outlook 97/Express

Turn the active graphic into a message in the 
designated, compatible E-mail program.

Netscape Mail
+ others

Turn the graphic into a GIF object that can be 
dragged and dropped into a suitable E-mail 
program.

Any E-mail program Save the graphic as a GIF file that can be 
attached to any E-mail message or used in 
another program. (Use the E-mail program’s 
Attach command.)

We recommend that you try each of the methods in order (until one works) to determine how your particular E-mail program 
responds.

To use the direct send method:

1 Click the  Send button or choose Send from the File menu.
2 If you have more than one compatible E-mail program installed, you’ll see a dialog asking you to designate one for sending 

graphic E-mail. 
MailPlus opens the designated E-mail program with the graphic inserted into a new message. 

3 Complete the message with Send To and Subject information, and accompanying text if any, then send it.

Note (America Online users only)
n If you’re using America Online’s E-mail program, start AOL before clicking the Send button. You only need to have the AOL 

application running — it’s not necessary to connect to the service until you’ve finished addressing your message and are 
ready to deliver it. 

If the direct send method doesn’t work...
n Your E-mail program most likely is not compatible. Try sending your message using the Package GIF option. For further 

information on E-mail program compatibility, check the MailPlus World Wide Web support page.

To use the Package GIF method:
1 Make sure your E-mail program is running, and open a new message window.

2 Click the  Package GIF button or choose Package GIF from the File menu. You will see a dialog with a small icon.
3 Drop the icon into the E-mail message window. 

Tip: If your E-mail message window is hidden, drag the Package icon down to the Windows Taskbar and pause over the 
button for your open E-mail message. The E-mail message window pops to the top.

4 Complete the message with Send To and Subject information, and accompanying text if any, then send it.

If the Package GIF method doesn’t work:

If you see a No Drop  symbol when attempting to drop the icon, your E-mail program won’t accept drag-and-drop GIF 
attachments. Send your message using the Save GIF method.



To use the Save As GIF method:

1 Click the  Save As GIF button or choose Save As GIF... from the File menu.
2 In the dialog, choose a path and file name for the graphic.
3 Run your E-mail program and open a new message window.
4 Click the Attach command (or equivalent) and browse to locate and attach the GIF file you saved. 
5 Complete the message with Send To and Subject information, and accompanying text if any, then send it.

Note
If you have more than one compatible E-mail program installed, choose Send Setup... from the File menu if you want to 
designate a different program as your default for graphic E-mail.



Saving Graphics

Saving the active graphic 
If you want to continue working on the graphic later on, save it as a MailPlus (.MPC) graphic. To turn the graphic into a picture 
file (for example, to use in an E-mail message or a Web page), save it as a .GIF file.

To save the graphic:
n Choose Save... from the File menu.
If the graphic is still Untitled, you’ll see the Save As dialog.

To save the graphic under a different name or in a different format:
n Choose Save As... from the File menu.

To save the graphic as a GIF file:

n Click the  Save As GIF button or choose Save As GIF from the File menu.

Saving a custom layout
You can also save a MailPlus graphic as a custom layout that appears in the 
“Custom” category in the Gallery's Layouts tab. (MailPlus creates this category when you save the first custom layout; it 
removes the category if you delete the last custom layout.)

To save a graphic as a custom layout:
1 Right-click on the graphic and choose Add to Custom.
2 Type a name for the custom layout and click Add. To maintain an attractive look for the Gallery’s layout list, use a short name 

(maximum 20 characters).

To rename a custom layout:
n In Windows Explorer, change the layout’s file name in the \Custom subfolder of the folder where you installed MailPlus. Keep 

the name short, and don't change the number or filename extension.

To delete a custom layout:
n In MailPlus, right-click the layout's name and choose Delete.

See Also
Composing Graphics



Adding Stamps and Floating Text

Stamps are colorful graphic elements (often combined with text) that can add emphasis to a graphic message. Floating text is a
special stamp that lets you place text anywhere on your graphic. Most stamps go on the Foreground layer of the MailPlus 
graphic. (An exception is the Compass stamp, which functions as a background “watermark.”)

To add a stamp to your graphic:

1 Click the  Stamps tab if it’s not already on top.
2 Click a stamp’s name to add the stamp to the graphic in the Edit Window.

OR
Drag the stamp from the Gallery and drop it into position on the layout.
The stamp appears on the Foreground layer of the active graphic.

3 If there’s sample text, type your own text to replace it. (See Replacing Sample Text.)

To add floating text:
n Choose the Plain Text stamp.

To cut, copy, paste, or delete a stamp: 
1 If the stamp isn't selected, click it. Selection handles appear around the stamp.
2 Right-click on the stamp and choose Cut, Copy, or Paste, or press the Delete key.

To resize a stamp:
1 If the stamp isn't selected, click it anywhere except on its text. Selection handles appear around the stamp.
2 Drag a selection handle to change the stamp's size.

To return to the stamp's original size, select the stamp if necessary by clicking it, then click the  Reset button.

To move a stamp:
1 If the stamp isn't selected, click it anywhere except on its text. Selection handles appear around the stamp.
2 Drag the stamp to the new location.

To change one stamp to another stamp:
1 If the stamp isn't selected, click it. Selection handles appear around the stamp.
2 Click the stamp you want to change to in the Gallery. The new stamp replaces the old one, but added text stays the same.

See Also
About Intelligent Formatting



Choosing a Design

Designs offer a range of backgrounds you can apply (to structure layouts only) to achieve a specific visual impact. Choose a 
design that's appropriate for your audience and the tone of your message.

Selecting a new design applies a visible border and background. MailPlus graphics using the Transparent design have a see-
through background with no border.

To choose a design:

1 Click the  Designs tab if it’s not already on top.
2 Click a design’s name to apply the design to the graphic in the Edit Window. Intelligent Formatting retains both sample text 

and added text.

Differences between transparent and non-transparent designs
n By default, MailPlus graphics created with a Transparent design do not have a title or subtitle. You can add these elements 

using the Text... command on MailPlus’ Insert menu.
n Graphics using the Transparent design have a Fit to Content option when resized. (See Resizing.)
n If you switch between transparent and non-transparent designs, MailPlus may add or remove sample text. Also, a texture 

you've added to the background of the graphic may appear or disappear.

See Also
Topics in the section, Working with Structure Layouts 



Choosing a Color Scheme

MailPlus provides three types of color schemes (for structure layouts only): monochrome, light background, and dark 
background. You can easily identify the colors used in a particular scheme by looking at the picture to the left of the color 
scheme's name in the Gallery. The color of the palette is the background color.

To choose a color scheme:

1 Click the  Color Schemes tab if it’s not already on top.
2 Click a color scheme’s name to apply the scheme to the graphic in the Edit Window. 

See Also
Topics in the section Working with Structure Layouts



Adding Texture

A texture is a visual effect that can add interest to the background of a MailPlus graphic (for structure layouts only) or to certain 
elements in the graphic.

To add texture to the background of a MailPlus graphic:

1 Click the  Textures tab if it’s not already on top. 
2 Click a texture.

To add texture to the background and all elements that accept texture:
n Hold down the Ctrl key when you click a texture.

To remove a texture:
n Apply the Clear texture.

Notes
n You can also add texture to the elements that accept texture and not to the background. Elements that accept texture include, 

for example, tables, positions in an Org Chart, satellites in an Orbit layout, or the boxes around text in some designs. Drag a 
texture and drop it on the element. If you drop a texture on a boxed point, MailPlus adds texture to all the points at that level.

n Chart elements (for example, bars, pie slices, and areas) do not accept texture.
n MailPlus graphics with the Transparent design don't display texture in their background. Clicking a texture in the Gallery when 

one of these graphics is active adds texture to any elements in the graphic that accept texture. Switching between transparent
and non-transparent designs may make background texture appear or disappear.

n If you change designs after adding a texture to the box around text, you won't see the texture if the text isn't boxed in the new 
design. The texture reappears if you switch to a design with boxed text.

See Also
Topics in the section Working with Structure Layouts

Note
This topic concludes the “Basics of Graphic E-mail” section. To continue perusing topics, click the Contents button.



Inserting New Elements

Elements are the “active” components of a layout’s Intelligent layer: text, pictures, tables, charts, and so on. To guide you when 
adding new elements to a graphic, MailPlus provides Invitations — visual prompts with sample text ready for you to type over.

To insert a new element:

n Click the  Insert button. Invitations appear when the Insert button is down.
n Click an Invitation prompt to edit it.

Invitations in picture layouts are generally limited to sample text at various locations. In structure layouts, invitations often include
other layout components. As soon as you edit an invitation (for example, by replacing its sample text), you’ve added an element 
to the graphic. Edit only the invitations you wish to become elements, and delete or turn off the others.    

To turn off invitations:
n Click the Insert button again. Unedited Invitations disappear when the Insert button is up.

See Also
Adding a Point or Sub-point
For more on modifying graphics, see the next several topics. 
For details on specific structure layouts, see the topics in the section Working with Structure Layouts.



Resizing

To resize a graphic:
n Drag a handle on the graphic's bounding outline.

To restore the graphic to default size:
n Click the current layout again.

Fitting a graphic’s size to its contents
The size and shape of a non-transparent MailPlus graphic (that is, those with a design other than Transparent) is not affected by 
the graphic's contents. When you add or remove elements, Intelligent Formatting scales the contents to fit inside the graphic.
The size and shape of MailPlus graphics with the Transparent design are affected by the setting for Fit Contents. To see the 
setting for Fit Contents, right-click a transparent graphic. (Fit Contents appears on the right-click menu only for graphics with 
the Transparent design.)
n When Fit Contents is checked, MailPlus removes unused space around elements in the graphic. When you add or remove 

elements, MailPlus changes the graphic's size as necessary to just fit its contents.
n If Fit Contents is off (unchecked) for a transparent graphic, MailPlus treats it like a non-transparent graphic design. 

See Also
Changing the Size of Text
Changing the Size of a Picture



Changing the Background and Border

To add or remove the background and border:

1 Click the  Designs tab if it’s not already on top.
2 Change the design.
To: Click: 
Remove the background and border The Transparent design
Add a background and border Another design

See Also
Choosing a Design



Changing Style

To change the style of a structure layout:
n Click a Style button below the Gallery.

The appearance and action of the Style button(s) depend on the layout of the MailPlus graphic and what's selected in it. (The 
Style button is not available for some layouts.)
Click: To change the: 

Glyph

Look of boxes that contain text when no text is selected.

Appearance of such things as bars, axes, axis labels, and the 
background area within the axes.

All designs have a default style that overrides the current style settings. You can use the Style button to make changes to the 
default style of most designs.

To return to the default style:

n Click the  Reset button. This also restores default sizes and resets changes made with several other buttons.



Editing Text

To insert text in existing text:
n Click where you want to insert and begin typing.

To change existing text:
n Highlight the text you want to change; then type the change, or press Ctrl+V to paste text from the clipboard.

To delete a text element:
n Select all of the element's text and press Delete.

To select all the text in a text element:
n Click just to the left of the element. You can also select all the text by dragging. 

To select the next or previous element:
n Press Tab to select the next element.
n Press Shift+Tab to select the previous element.

To undo editing changes:
n Choose Undo from the Edit menu.

To insert a line break at a particular place:
n Press Shift+Enter.

Notes
n Don't be concerned with where lines end when you edit text. MailPlus adjusts line breaks when you finish editing.
n When selecting bullet points, you can press the Up or Down Arrow keys to select the next or previous element.
n When you finish editing, click the background of the MailPlus graphic.

See Also
Replacing Sample Text
For more on working with pictures, see the next several topics.



Adding a Title, Subtitle, Top/Bottom Text, or Sign-off

To add a title, subtitle, top/bottom text, or sign-off:
1 Choose Text... from the Insert menu and select the element you want to add from the submenu.
2 Type your text, replacing the sample text.
3 Click the background of the MailPlus graphic when you finish typing.

Notes
n The available choices on the Insert/Text... submenu vary, depending on the design of the MailPlus graphic and the elements 

it contains.
n You can use the Insert button to add most text elements to most designs, but use Insert/Text... to add a title or subtitle to a 

graphic with the Transparent design.

See Also
Adding Stamps and Floating Text 



Adding a Point or Sub-point

Hierarchies of points and sub-points are especially important in structure layouts, where they serve to organize the information in
your message. MailPlus makes it easy to modify points and sub-points, and uses Intelligent Formatting to preserve these 
relationships as you switch layouts.

To add a point:
1 Click the point above or before where you want to make the addition.
2 Press Enter.
3 Type the text for the new point.
4 Click the background of the MailPlus graphic when you finish typing.

To add a point before an existing point:

n Click the existing point and then click the  Insert button.
When you click the button, an invitation for adding a new point appears before a selected point, or at the end of the body if no 
point is selected.

To add a sub-point:
1 Click the point you want to add a sub-point to.
2 Press Ctrl+Enter.
3 Type the text for the sub-point.
4 Click the background of the MailPlus graphic when you finish typing.

You can also add a point using the Insert menu (see previous topic). To add more points or sub-points, press Enter when you 
finish typing instead of clicking the background.

Notes
n Some points don’t support adding further points or sub-points.
n To add another sub-point to a point that already has sub-points, click an existing sub-point and press Enter.

Splitting and merging points
To split an existing point into two points:
n Click where you want the second point to begin and press Ctrl+Down Arrow.

To merge two points:
n Click the second point and press Ctrl+Up Arrow.

Note: Some points don't support splitting or merging.

To start a new line within a point:
n Click where you want the new line to begin and press Shift+Enter.

See Also
Changing the Indent of a Point or Sub-point



Changing the Size of Text

To make text bigger or smaller:
1 Click the text you want to change.
2 Click a button to change the size.
Click: To: 

Make the text bigger.

Make the text smaller.

To return to the original text size:

n Click the  Reset button. This also restores the default style and resets changes made with several other 
buttons.

Notes
n If you're changing the size of points or sub-points, select just one of them. MailPlus changes all the points at the same level.
n If no text is selected, the Bigger and Smaller buttons change the size of body text.
n To make text as large as possible, hold down the Ctrl key when you click the Bigger button.
n You can fix unattractive line breaks by changing the size of the text. For example, make text smaller to move a single word on 

the last line up to the previous line.
n When you change text size, MailPlus adjusts the size of other items on the Intelligent layer.

See Also
Resizing
Changing Style



Moving or Copying Text

To move text:
1 Move the pointer to the left of the text until the pointer changes to an arrow that points to the right.
2 When you see the right-pointing arrow, drag the text to the new location.
3 Release the mouse button to drop the text.
If you  ’  re moving:   Drop the text: 
Within the body At the new location.
Outside the body On one of the drop targets that appear on the 

Intelligent layer.

To copy text:
1 Hold down the Ctrl key while you drag the text.
2 Drop the copy as if you had moved it.

Notes
n When you move or copy a point, its sub-points stay with it.
n Text is restricted to the Intelligent layer; you can't move it to the Background layer or Foreground layer. To put text on the 

Foreground layer, add a Plain Text stamp.
n You can also use the Cut or Copy and Paste commands on the Edit menu (or right-click menu) to move or copy a point.

See Also
For basic information about MailPlus layers, About Intelligent Formatting
Changing the Indent of a Point or Sub-point
Adding Stamps and Floating Text



Changing the Font

To change the text font:
1 Choose Font from the Edit menu.
2 Select the new font, then click OK.

Note
n You can set only one font at a time for a MailPlus graphic.



Checking Spelling

To check spelling:
1 Choose Spelling... from the Edit menu, or right-click the graphic and choose Spelling....
2 When MailPlus displays a questionable word, correct or accept the word.
To: Do this: 
Skip the word Click Ignore.
Fix the word Type a correction in the Replacement box and click Replace.
Use a 
suggestion

Double-click a word in the Suggestions box.

Notes
n To add a word to your custom dictionary so it isn't questioned again, click Add to Dictionary.
n To prevent MailPlus from questioning words, like acronyms, that use only capital letters, set Ignore words in ALL CAPS.
n When MailPlus checks spelling, it questions a word that differs only in capitalization from a word in your custom dictionary. To 

prevent this, add the word again with the alternative capitalization.



Changing the Indent of a Point or Sub-point

To promote (move left):
1 Click the point or sub-point.
2 Press Ctrl+Left Arrow.

To demote (move right):
1 Click the point or sub-point.
2 Press Ctrl+Right Arrow.

Note
n You can also drag the point or sub-point to the new indentation.

See Also
Adding a Point or Sub-point



Adding a Picture or Background

It’s easy to add a picture to your graphic. You import the picture to the Intelligent layer, and can then move or resize it, or create 
a background from it. Your picture file can be in any of these formats:

Windows Metafile (.WMF, .EMF)
Windows Bitmap (.BMP, .DIB)
Tagged Image Format (.TIF)
Graphics Interchange Format (.GIF)
PC Paintbrush (.PCX)

For basic information on MailPlus’ layers, see About Intelligent Formatting.

To add a picture to the Intelligent layer:
1 Choose Picture... from the Insert menu.
2 Select the picture file and click Open.

To create a background from a picture:
1 Click the picture.D_picture

2 Click the  Background button.
MailPlus moves the picture to the Background layer, and scales it to full frame. 

n If the full-frame picture appears distorted, set Normal scaling (see Changing Scale Settings).

n If text on top of the picture (the Intelligent layer) is difficult to read, click the picture and then click the  Fade Color button.
You can also resize and move a picture on the Background layer so text does not appear on top of the picture (see the next 
topic).

Notes

n To tint a bitmap picture on the Background layer to match the color scheme of the MailPlus graphic, click the  Match 
Color button.

n To restore the original colors, click the picture and then click  Fade Color.

See Also
For more on working with pictures, see the next several topics.



Moving or Copying a Picture

The way you move or copy a picture depends on whether it's on the Intelligent layer, the Foreground layer, or the Background 
layer. MailPlus restricts the placement of pictures on the Intelligent layer, but you can drag a picture anywhere on the Foreground
or Background layer. To determine which layer a picture is on, make sure it's selected and check which placement button is 
depressed. Click the picture to select it, if necessary.
For basic information on MailPlus’ layers, see About Intelligent Formatting.

To move a picture on the Intelligent layer:
n Drag the picture to a drop target (shown as a small rectangular symbol).

To copy a picture on the Intelligent layer:
n Hold down the Ctrl key as you drag.

When you move or copy a picture on the Intelligent layer, MailPlus adjusts the picture's size and the size of other elements on 
the layer.

To move a picture from the Intelligent layer to the Foreground or Background layer:
1 Click the picture, if it’s not already selected.
2 Click a button to indicate the destination.
Click: To move to the: 

Foreground layer.

Background layer. When you move a picture to the Background layer, 
MailPlus resizes it to fill the layer.

To move a picture on the Foreground or Background layer:
n Drag the picture to a new location.

To copy a picture on the Foreground or Background layer:
n Use Copy and Paste on the Edit menu (or the right-click menu). 

MailPlus pastes a copied picture on top of the original picture. Drag the copy to its new position.



Changing the Size of a Picture

To change the size of a picture on the Intelligent layer:
1 If the picture isn't selected, click it.
2 Click a button to change the size.
Click: To: 

Make the picture bigger.

Make the picture smaller.

To change the size of a picture on the Foreground layer or Background layer:
n Drag a handle at the corner of the picture.

To change the proportions of a selected picture on the Foreground or Background layer:
n Set the picture's scale option to Stretch and drag a handle on a side of the picture.

See Also
Changing Scale Settings



Changing Scale Settings

Scale settings determine how the size of a picture adjusts to fit inside the graphic as a whole. 

n Set Normal scaling to allow MailPlus to control the size of the picture. Depending on its placement, the size of the picture 
might change, but its proportions remain the same.

n Set None for a bitmap file, like a logo, that you don't want MailPlus to scale. The picture's size is determined by the number of 
pixels in its height and width. The size might change depending on the resolution of the output device (printer or screen), but 
does not vary with placement.

n If you set Stretch, you can change the proportions of a picture placed on the Foreground layer or Background layer by 
dragging the handle on a side of the picture.

To set scaling for a picture:
1 Right-click a picture on the Intelligent layer and select Properties....
2 Set the scaling.
Set: To: 
Normal Maintain the original picture's proportions
Stretch Fill the region with the picture
None Remove any scaling from a bitmap

4 Click OK.



Adding an OLE Object

To add an OLE object:
1 Choose Object from the Insert menu.
2 Set a Create button.
Set: To: 
Create New Create a new OLE object.
Create from File Insert an existing object file.

3 Set options in the dialog box.
If you set: Do this: 
Create New Click the program you'll use to create the OLE object.
Create from File Select an existing file. (Click Browse to locate the file.)

n To link the OLE object in the MailPlus graphic with the OLE object's file, set Link.
4 Click OK.

Notes
n To edit an OLE object, double-click it in the MailPlus graphic.
n If you don't set Link, you put a copy of the OLE object file in the MailPlus graphic. Changes you make in this copy don't 

appear in the original file, and changes in the original file don't appear in the copy.
n You can also add an OLE object by copying it in the source program, then choosing Paste Special... from the Edit menu.

See Also
Moving or Copying a Picture
Changing the Size of a Picture



Comparisons

Ratings
To change a rating:
n Click the cell with the rating you want to change.
n For Ratings layouts using circle and diamond symbols, click the cell repeatedly to cycle through the rating alternatives.
For: Click to see: 
Circles No circle, empty circle, half-filled circle, filled circle
Diamonds Zero to four diamonds

Stock Arrows
To edit data in a Stock Arrows layout:
1 Click the value you want to change.
2 Make changes in the edit box.
3 Click the background of the MailPlus graphic when you finish editing the data.

To add a note to the right of a stock arrow:
1 Click the stock's name.

2 Click the  Insert button and type the note at the sub-point invitation. 
3 Click the background of the MailPlus graphic when you finish typing.

To add a third (or additional) arrow:
n Press Enter.

Stock Tables
To edit data in a Stock Table layout:
1 Click the cell you want to change.
2 Make changes in the edit box.
3 Click the background of the MailPlus graphic when you finish editing.

To change the value in a Volume cell:
1 Click the cell.
2 Type the new value.
3 Click the background.

See the next topic for instructions on adding extra rows and columns.

See Also
Choosing a Design
Choosing a Color Scheme
Adding Texture



Tables

To add a row to a table:
1 Click a cell in the row below where you want the new row.

2 Click the  Insert button.
3 Click the invitation for a new row.
4 Type your text or data, replacing the sample text.
5 Press the Right Arrow key and type the contents for the next cell.
6 Continue pressing the Right Arrow key and typing until the row is complete.
7 Click the background of the MailPlus graphic when you finish typing.

Note: To add a row after the last row, click in the first cell of the last row and press Enter.

To add a column to a table:
1 Click a cell in the column to the right of where you want the new column.

2 Click the  Insert button.
3 Click the invitation for a new column.
4 Type your text or data, replacing the sample text.
5 Press the Down Arrow key and type the contents for the next cell.
6 Continue pressing the Down Arrow key and typing until the column is complete.
7 Click the background of the MailPlus graphic when you finish typing.

Note: To add a column after the last column, click in the first cell of the last column and press Enter.

To delete a row or column:
n Select the text or data in the first cell of the row or column and press Delete.

To transpose a table (swap rows and columns):

n Click the  Flip button.

See Also
Choosing a Design
Choosing a Color Scheme
Adding Texture



Charts

Working with Chart Data
To review chart data:

1 Click the  Show Chart as Table button. Chart data appears in a table when the button is down.
2 Click the button again when you finish examining the data. The chart reappears when the button is up.

To add data to a chart:

1 Click the  Show Chart as Table button.
2 Add a row or column to the table, as appropriate.
3 Click the button again when you finish adding the data.

Note
You can also add data directly to the chart by clicking a chart element and then pressing Enter.

To edit data values and labels:
1 Click the value or label you want to change.
2 Type your change.
3 Click the background of the MailPlus graphic when you finish typing.

Note
n If you want to make many changes, it may be easier to switch to a table layout before editing.

Changing the Chart Display
To change the display of data values:
n Click the Values button repeatedly to see the alternatives.
The appearance and action of the Values button depend on the type of chart:
Click: To: 

Show or hide data values for Bar, Column, Line, and Area charts.

Cycle through the alternatives for Proportional Bar and Column 
charts, Pie charts, and Pyramid charts. You see values only, both 
values and percentages, percentages only, or neither values or 
percentages.

To show or hide a legend:

n Click the  Legend button.

To transpose the axes of an Area, Bar, Column, or Line chart:

n Click the  Flip button. This swaps the dimension shown in the chart's legend for the dimension shown on the 
non-numeric axis.

Notes
n Pie and Pyramid charts don't have legends.
n Click the legend title region to add a legend title. Click the title to edit it.

To rotate a chart:

n Click the  Rotate button repeatedly to cycle through different rotation angles.

Note



You can rotate Area charts, Pie charts and the 3-D varieties of Bar, Column, Line, and Pyramid charts.

Pie Charts
To separate a pie slice:
1 Click the slice you want to separate.

2 Click the  Slice button.
Repeat these steps to return the slice to the pie.

Note
The Slice button is not available for separated variations of the Pie layout.

See Also
Choosing a Design
Choosing a Color Scheme
Adding Texture



Lists

To check off items on a To Do list:
n Click the box in front of the item. Click again to remove the check mark.

See Also
Choosing a Design
Choosing a Color Scheme
Adding Texture



Calendars

To change the day, week, or month:
1 Click the element you want to change.
2 Make changes in the edit box.
3 Click the background of the MailPlus graphic when you finish editing.

Notes
n To change a time period in the Agenda layout, click it and type your change.
n You can set any date in the Week layout. MailPlus displays the dates for the Sunday and Saturday of the appropriate week.
n In the Day, Week, or Month layout, you can quickly change to the previous or next day, week, or month:
Click: For the: 

Previous day, week, or month.

Next day, week, or month.

n MailPlus uses the Regional Settings from the Windows Control Panel for displaying dates. Use the Control Panel to change 
date format.

To highlight a date in the Month layout:
1 Click below the number of the date you want to highlight.
2 If the date has an appointment, click the appointment.

3 Click the  Highlight button.

Notes
n You can highlight more than one date.
To remove a highlight, repeat the steps for adding the highlight.

See Also
Choosing a Design
Choosing a Color Scheme
Adding Texture



Scheduling

Timeline layouts
In a timeline layout, you can change the appearance of the bar below the events or add glyphs to the events.

To change the appearance of the bar below the events:

n Click the  Format Dateline button.

To add glyphs to the events:
1 Click an event.

2 Click the  Glyph Style button. Glyphs appear to the left of the event names.

Gantt chart layouts
In a Gantt chart layout, you can change the starting date or duration of a task, add a task, display a milestone, change the 
appearance of the date bar or duration bar, or add glyphs to the events.

To change the starting date or duration of a task:
1 Right-click the name of the task.
2 Choose Start and Duration.
3 Make changes in the dialog, then click OK.

To add a task:
1 Click the name of the task that's above the position where you want the new task.
2 Press Enter. The task appears as a milestone (diamond) symbol.
3 Type a name for the new task.
4 Press Tab.
5 Make changes in the edit box. 
6 Click the background of the MailPlus graphic when you finish editing. Tasks with durations appear as bars.

To display a milestone:
n Click a task's duration and set it to zero.

To change the appearance of the bar containing the dates:

n Click the  Format Dateline button.

To change the appearance of the duration bars:
1 Make sure you have not clicked a duration bar.

2 Click the  Border Style button.

To add glyphs to the events:
1 Click an event.

2 Click the  Glyph Style button.

Notes
n To change the starting date of the chart, change the starting date of the first task. You can set any date as the starting date. 

MailPlus calculates the end date based on the duration of the tasks.
n Milestones appear as a diamonds.



n Clicking the Style button changes the glyph when the insertion point is in a task or a task's name is selected.

See Also
Choosing a Design
Choosing a Color Scheme
Adding Texture
Moving or Copying Text



Glossary
Click a word to see its definition.
Background layer
body
bottom text 
category
Color Scheme
Design
dither
drop targets
Edit Window
element
embed
Foreground layer
Gallery
glyph
invitation
Intelligent Formatting
Intelligent layer
Layout
link
logo
OLE object
picture
picture layout
pixel
sample text
point
region
Stamp
structure layout
style
sub-point
Texture
top text 
Transparent design
variation



Background layer

The underlying layer of a MailPlus graphic. Elements on the Intelligent layer and Foreground layer appear on top of the 
Background layer.



body

The main region of a MailPlus graphic that contains points and sub-points.



bottom text

Text you can add to the bottom of a MailPlus graphic.



caption

Text you can add to a picture in a MailPlus graphic. A caption appears below the picture. If you move the picture, the caption 
moves with it.



category

A collection of layouts having a common purpose. For example, the Calendars category includes layouts for graphically 
representing daily, weekly, and monthly time frames.



Color Scheme

A choice on the third tab of the MailPlus Gallery. Color schemes select and coordinate the colors used in MailPlus structure 
layouts.



Design

A choice on the second tab of the MailPlus Gallery. Designs determine the overall appearance of a MailPlus graphic. Each 
design ensures that all elements in the graphic are positioned to look balanced and in proportion. You can use the Designs tab to
vary the appearance of structure layouts.



dither

To combine dots of different colors to create the illusion of another color.



drop targets

Phrases or symbols that identify available destinations when you drag elements on the Intelligent layer. Phrases appear for text; 
small rectangular symbols appear for pictures.



Edit Window

The main window displaying the active graphic.



element

A component of a MailPlus graphic. Text, pictures, tables, charts, and other graphic components of the layouts (for example, a 
pyramid or a flow diagram) are elements.



embed

To add an object created by another program to a MailPlus graphic. You can use the original program to edit the embedded 
object within the MailPlus graphic. Embedded objects are not linked to a file created by another program.



Foreground layer

The surface layer of a MailPlus graphic. Elements on the Intelligent layer and Background layer appear beneath the Foreground 
layer.



Gallery

The area containing the tabs, lists, and buttons you use to compose a MailPlus graphic.



glyph

The number, check mark, or bullet preceding text in some layouts. Bullets can be diamonds, triangles, squares, circles, and 
dashes.



Intelligent Formatting

The graphic design intelligence built into MailPlus that arranges and scales text and pictures in a MailPlus graphic. Regardless of
changes, Intelligent Formatting keeps elements in the graphic looking balanced and in proportion.



Intelligent layer

A “transparent” layer in a MailPlus graphic, where the selected layout and design determine the size and placement of elements.
The Intelligent layer appears between the Background layer and the Foreground layer.



Invitation

Text that appears in the active MailPlus graphic when you click the Insert button in the MailPlus Gallery. Invitations indicate which
elements you can add to the MailPlus graphic and where to type text for these elements.



Layout

A choice on the first tab of the MailPlus Gallery. Layouts arrange and display information in a MailPlus graphic according to the 
concept being conveyed. Choose a layout that reinforces the message you want to communicate.



link

To create a connection between an object from another program and an element in a MailPlus graphic.



logo

A distinctive symbol or graphic representing a company, product, or the like. In MailPlus, a logo is a picture that you can add to 
the left of the title (and often to the right as well).



OLE object

A component that is created with one program and added to a document created by another program. You can embed or link the 
OLE object when you add it to a MailPlus graphic.



picture

A graphic image that can be added to a MailPlus graphic. A picture can be Microsoft ClipArt or a file in any of the following 
formats:    Windows Metafile (.WMF, .EMF), Windows Bitmap (.BMP, .DIB), Tagged Image File Format (.TIF), Graphics 
Interchange Format (.GIF), or PC Paintbrush (.PCX).



picture layout

An MailPlus layout (such as a Greeting Card, Invitation, or Certificate)    with a full-frame pictorial background, especially suitable 
for illustrated notices and correspondence. Picture layouts are usually less complex than structure layouts.



pixel

Picture element. The smallest element of a computer screen that can be assigned color. The greater the number of pixels, the 
better the clarity of a picture.



point

An element covering a detail about the main idea conveyed by the MailPlus graphic. Points represent different items in different 
layouts. For example:
Layout: Point: 
Headings a heading
Org Chart a position
Flow a step
Table a row or column
Pie Chart a slice
Column Chart a series or a column
Bullets an item in the list
Time Line an event
Gantt Chart a task

region

An area of the Intelligent layer. Text regions include title, subtitle, top text, bottom text, body, and sign-off. Picture regions include 
relative locations on the page, such as top, bottom, upper left, and lower left. Not all designs have every region.



sample text

Built-in, helpful text supplied by MailPlus. You replace it with the actual text you want to appear in the graphic.



sign-off

Text you can add to the bottom-right of a MailPlus graphic.



Stamp

An element of a MailPlus graphic that combines text with a graphic to send a particular message. Placed on the Foreground 
layer (except for the Compass stamp). Intelligent Formatting manages the text size and colors of stamps for you. A stamp can be
the only element in a MailPlus graphic. 



structure layout

An MailPlus layout (such as a Calendar, Relationship, Table, or Chart) that presents organized information, especially suitable for
business and project communcations. Structure layouts are usually more complex than picture layouts.



style

    

    

A group of settings that controls details of the appearance of a MailPlus graphic. Clicking the Style button cycles through sets of 
visual variations for the current layout. The appearance of the Style button changes depending on the current layout and what's 
selected in the graphic.



sub-point

An element that amplifies or supports the point to which it refers.



top text

Text you can add to the top of a MailPlus graphic.



Texture

A choice on the fifth tab of the MailPlus Gallery. A visual effect that can add interest to the background of a MailPlus structure 
layout or to certain elements in the graphic.



Transparent design

The first choice on the Designs tab in the MailPlus Gallery. MailPlus graphics with the Transparent design have a see-through 
background. By default, transparent graphics don't have a title, subtitle, sign-off, or top/bottom text, but you can add these text 
elements if you want.



variation

A modification of a basic layout type. For example, pie chart variations include layouts for 3-D pie charts, pie charts with 
separated slices, and donut charts.



Contact Information and Technical Support

If you have a technical problem and you can't find the solution in online Help:
1 Note the sequence of events that led to the problem, and any program messages you see.
2 Contact Technical Support. Have MailPlus running on your computer when you call, and have your registration number handy.

Note
For technical information and late-breaking tips on using MailPlus, consult the MailPlus Frequently Asked Questions page on the 
World Wide Web.

Contacting Technical Support
United States Call    (603) 886-6642

Fax    (603) 889-1127
E-mail: support@serif.com

Europe Call +44 115 914 9090
Fax + 44 115 914 2020
E-mail: support@serif.co.uk

UK Call (0115) 914 9090 
Fax (0115) 914 2020
E-mail: support@serif.co.uk

Australia Call 1800 657 542
New Zealand Call 0800 801 727

Other Countries Contact your local distributor.

Additional Serif contact information
Main office (USA, Canada):

Serif SPC
PO Box 803, Nashua NH 03061, USA

Main (603) 889-8650
Registration (800) 794-6876
Sales (800) 55-SERIF or 557-3743
Customer Service (800) 489-6720
General Fax (603) 889-1127
Sales Fax (603) 886-4919

European office (UK, Europe):
Serif (Europe) Limited
The Software Centre, PO Box 2000, Nottingham, NG11 7GW, UK

Main (0115) 914 2000
Registration (0500) 454 645
Sales (0800) 376 7070
Customer Service (0115) 914 9090
General Fax (0115) 914 2020

On-line product and company information
Internet http://www.serif.com
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1Send yourself graphic E-mail!{ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

Welcome to the Walkthrough... 
A few minutes from now, you’ll have 
sent your first MailPlus message!
To continue, click the Next button at 
left. (Click Menu at any time to return
to online help.)

2Setting up the Walkthrough{ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

To get started, drag this 
Walkthrough window over to the 
lower left corner of your screen. 
Drag MailPlus to the upper right.
Tip: Click on either window’s titlebar
to switch between the two during the
Walkthrough.

3Parts of the MailPlus window{ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

First, notice the parts of the MailPlus
window:
• the Edit Window, where you add 
text and view the active graphic; 
• the Gallery, where you use the tabs
to select graphic elements.

4The sample graphic{ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

Choose New from the File menu. 
Notice the sample graphic in the Edit
Window that begins each new 
session.
To create your own graphic, you 
modify this sample graphic.

5Take a look at the Layouts{ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

Click the Layouts tab on the Gallery 
to make sure it’s in front. 
The Layouts tab offers a selection of
message graphics in a variety of 
categories. Notice that one group is 
highlighted under the category 
Greeting Cards.

6Layout categories{ewc HLP25632,HLP256_TILE,bkgnd4.bmp}



Click any category name (for 
example, the words Greeting Cards) 
to collapse the layout categories.
Notice the other category names.
Now click the category Invitations to
expand it again.

7Choosing a layout for your graphic{ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

Under Invitations, click the down 
arrow  next to Other Parties to 
display the names of the various 
layouts in this group.
Now click Picnic.
MailPlus applies the selected layout to
the active graphic.

8Exploring some more {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

Take a few moments to explore 
some of the other categories and 
click other layout names. 
Notice that each layout includes its 
own sample text — a placeholder for
your own message text.
Return to the Picnic Invitation.

9Adding your own text {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

In the active graphic, click on the 
words It’s Picnic Time. 
Just start typing to replace the 
sample text with this new text: 
Introducing Graphic E-mail
When you’re done, click on the 
graphic outside the text.

10Resizing the graphic {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

Drag the graphic from its lower right 
corner to make it smaller. 
The graphic’s size in the Edit 
Window determines its size in your 
E-mail message.
Click the layout name (Picnic) to 
restore the graphic’s original size.

11Intelligent Formatting {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

As you add text, modify the graphic, 
or resize it, MailPlus uses Intelligent 
Formatting to keep all the elements 
of the graphic in balance. 

12Tabbing through text {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}



Pressing the Tab key cycles through
the blocks of sample text. 
Click outside the text, then press 
Tab until the middle block 
(All the food...) is highlighted.
Type this replacement text:
Wake ‘em up!

13 Deleting text {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

Pressing Shift+Tab cycles back 
through the sample text. 
Press Shift+Tab until Friday at 10am 
is highlighted.
Press the Delete key to delete this 
block of sample text.

14Displaying “invitations” for new text {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

Tab (if necessary) so that 
Wake ‘em up! is highlighted.
Now click the Insert button to 
display invitations — sample text at 
specific locations on the graphic, 
ready to type over.

15Adding a sub-point {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

Click on the invitation text Click for 
Sub-point and type to replace the 
sample text with Your message 
deserves attention. 
Click the Glyph Style button six 
times to change the bullet to a check
mark.

16Changing text size {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

Select the text Wake ‘em up! and 
then click the Bigger button about 
10 times — until the text spans 
about two-thirds of the billboard 
space.

17Inserting a sign-off {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

Choose Text from the Insert menu 
and select Sign Off from the 
submenu. 
Type your name over the sample text
in the sign-off region at the lower 
right.

18Adding a starburst stamp {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}



Click the Stamps tab. 
Click the Starburst stamp to insert a 
starburst on the Foreground layer of
the active graphic.
Notice the sample text of the stamp 
is already selected.

19Customizing the stamp {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

Type to replace the sample text with 
the word “POW!”
When you’re done, click the 
starburst outside its text. (You’ll see 
the selection handles.) 
Drag the starburst and position it to 
the right of Wake ‘em up!

20Using the Insert menu {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

Later on, you can try using the Insert
menu to import a picture (such as a 
BMP or GIF) and create a custom 
background...

...or add new subtitles, points and 
sub-points, or sign-offs.

21About Structure Layouts {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

MailPlus’ powerful structure layouts 
(like calendars, charts, schedules, 
and tables) are great for organizing 
information in business and project 
communications.

22Other Gallery tabs {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

You can use the other Gallery tabs 
(Designs, Color Schemes, and 
Textures) to add variety and 
excitement to structure layouts.

23 And by the way... {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

You can add new layouts, designs, 
and color schemes to MailPlus with 
content packs.
You’ll find details in online help. 
(See the Help on Help topic.)
But right now it’s time to send your 
graphic E-mail message!

24Special note to America Online users {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}



If you’re using America Online’s 
E-mail program, you’ll need to have 
AOL running before you can send 
graphic E-mail.
Start AOL now. 
(You don’t have to connect yet — 
that comes later.)

25First, try the direct Send approach {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

Click the MailPlus Send button.
Note: If you see a dialog asking you 
to designate a particular program for
sending graphic E-mail, make your 
selection now. (You’ll only see this if
you have more than one E-mail 
program installed.)

26Did the E-mail program respond? {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

If you have a suitable E-mail 
program, MailPlus opens it with your
graphic inserted into a new 
message. (To continue, click Next.)

Note: If nothing happened, click here
to try a different send option.

27Finishing touches {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

In your E-mail program, complete 
the message with: 
• Send To and Subject information
• accompanying text if any
            ...and then send it!
(E-mail program button shown)

28Misson accomplished! {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

You can use the direct Send method 
with your current E-mail program.

To return to online help, click Menu.

27Preparing a new message window {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

Make sure your E-mail program is 
running, and open a New Message 
window.
(E-mail program button shown)

28Packaging the graphic as a GIF {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}



Click the MailPlus Package GIF 
button.

This will bring up a dialog with a 
small icon, ready to drag and drop 
into the E-mail message window.

29How to show the message window {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

Tip: If your E-mail message window 
is hidden, drag the Package icon 
down to the Windows Taskbar. 
Pause (with the mouse button down)
over the button for the “new 
message,” and the window will pop 
to the top.

30Using drag and drop {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

Drop the icon into the message 
window. If it appears as an 
attachment, click Next at left.

Note: If you see a No Drop symbol 
over the message window, click here
to try a third send option.

31Finishing touches {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

In your E-mail program, complete 
the message with: 
• Send To and Subject information
• accompanying text if any
            ...and then send it!
(E-mail program button shown)

32Mission accomplished! {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

You can use Package GIF with your 
current E-mail program. 
Note: To use direct Send, you’ll need
to upgrade to a compatible E-mail 
program.

To return to online help, click Menu.

5 PKG 7 {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

asdf

5 PKG 8 {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

adfasdf

31Saving the graphic as a GIF file {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}



Here’s a method that will work with 
any E-mail program.
Click the MailPlus Save As GIF 
button.
Use the dialog to specify a path and 
file name for the graphic.

32Attaching the graphic {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

You should already have your 
E-mail program running, with a 
New Message window open.
Click the Attach button (or 
equivalent) and browse to locate and
attach the GIF file you saved.
(E-mail program button shown)

33Finishing touches {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

In your E-mail program, complete 
the message with: 
• Send To and Subject information
• accompanying text if any
            ...and then send it!
(E-mail program button shown)

34Mission accomplished! {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

You can use Save As GIF with your 
current E-mail program. 
Note: To use direct Send, you’ll need
to upgrade to a MAPI-compliant E-
mail program.

To return to online help, click Menu.

5 SAV 7 {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

adfasdf

5 SAV 8 {ewc HLP25632,HLP256_TILE,bkgnd4.bmp}

adfafd




